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Steps for Converting a Word Document into Proper Format for
Screening of Figure Legibility and Paper Length by the Combustion Institute

These step-by-step instructions are designed to allow an average Word user to reformat a paper,
while avoiding some potential problems with Word. An average Word user should be able to
reformat a paper in about one hour. This task will be easier if the original Author instructions
for submitted papers were followed. Authors should apply those instructions BEFORE
reformatting. Format need not be perfect to judge length and figure legibility.

Authors who determine that their paper is too long may want to consider shortening the column-
formatted version and then converting a copy of this shortened paper to the double-spaced,
single-column format required by Elsevier. This may save time if there are extensive revisions.

Details will depend on the version of Word. Windows shown here are from Word XP.

If you have problems with this reformatting process that cannot be resolved locally, contact
Robert Barlow, Sandia National Laboratories, (barlow(@ca.sandia.gov).

1. Print these Instructions (pages 2-11 of this pdf file).

2. Make sure you preserve a copy of the original paper (Version 1).

3. Save a copy of your paper, naming the file with your paper ID number followed by “-
formatted.” (For example. Save As: PID12345-formatted.doc)

4. Place Tables and Figures at the end of the paper with a Page Break before the first table or
figure.

5. Format each figure to be “In line with text.” FormaERER 2|

Colors and Lines | Size | Ficture I Texk Box | Web I

Double-click on the figure to show the Format
Picture command window or go to “Picture ...”
under the Format menu. Click on the Layout tab
and select “In line with text”. Click OK.

Wrapping skwle
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Align each figure on the left margin (align left) Horizantal alignment
as opposed to centered on the page. Ol Ccener  CRgt & Other

— .ﬂ.lign Left Advanced. .. |

oK I Cancel




Place each figure caption under the corresponding figure. Skip a line between figure and
caption, and leave a blank line after each caption.

Delete all information that will not be included in the formatted version. Consult the
example for what to include.

a. Delete extra Cover page information.

b. Ifthere is a separate list of figure captions, delete it, or move it to a separate page at
the end of the document.

Set the page Type to US Letter (8.5in by 11 in). 21x

Use Page Setup...under the File menu.

Margins
Paper size:
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Width: g.5" =
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Set the margins to: Page Setup 21
Top= 1.0in Bottom = 1.5 in Marains | poper | Lovout |
Margins
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(368 rnm) (356 mm) Gutter: IU" 3‘ Gutter position: ILeFt vI
Select “Apply to: Whole document” R
Click OK. ’
Portrait Landscape
Pages
. . . Multiple pages: INUrmaI j
This creates a printed area of 8.5-inch (216
mm) in height by 5.65 inch (144 mm) in width. N
Alternative paper size and margins may be used, Apply to:
as long as this printed area is preserved. [whole document N [

Default. .. | (04 I Cancel




10. Select the entire document. Use [Ctrl-A ] or
Select All under the Edit menu.

11. Go to “Paragraph...” under the Format menu
and apply Single line spacing to the entire
document.

Click OK.
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Indents and Spacing | Ling and Page Breaks I
General
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Indentation
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Preview
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12. Insert blank (skipped) lines as listed:

a. Six before the title

b. One between Title and Authors

c. One between Authors and Affiliations
d. Five between Affiliations and Abstract
e. One between Abstract heading and text
f.  One before the Keywords

g. Five between Keywords and
Introduction (or first section heading)

h. One before and after each major heading
and each subheading

i.  One before each sub-subheading (if
used). Do not skip a line after a sub-
subheading.

13. Remove any blank (skipped) lines between
paragraphs of text within the Abstract or body of
the paper.

14. Remove any blank (skipped) lines between
references.




15. Select the complete text from the first line of the 20
file to the final line of the references. Indents and Spacing | Line and Pags Breaks |
. . . eneral
Click the cursor at the beginning of the file, : agrert: o 7] outing level:  [Bodytet =]
Scroll to the end of the text, and then e
[Shift-Click] after the last reference. Left: o’ 5 Special By:
) . e Bight: o = oo 7] =
16. With the entire text selected (highlighted), set
the paragraph line spacing to “Exactly” 10 pt. Spacing
« v Before: ID Pt E‘ Line spacing! At
Go to “Paragraph...” under the Format menu. At o = [y =] [om =
Clle OK ™ Don't add space between paragraphs of the same style
Note that this will squash equations to 10 pt Preview
height, but we will switch those back to single
line spacing later.
Note that 9 pt font and 10 pt line spacing (9/10)
is the most common format, so it is efficient to Tabs.. | x| coneel
apply it to all the text and then reformat the
special cases.
17. With the entire text still selected, set font size to | EE T 2|
9 pt. Go to “Font...” under the Format menu. Font | Character Spacing | Text EFfects |
. Font: Fant style: Size:
Click OK. | [
e S e co—
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Effects
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18.

Make sure that all sections from the Abstract
through the References are justified. (right and
left).

Select the text from the abstract to the end of the
references.

a. Click the cursor on a blank line below
the author affiliations,

b. Scroll to the end of the reference list, and
then

c. [Shift-Click] at the end of the references.

Go to “Paragraph...” under the format menu (at
right) or click on the “Justify” button.
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19. Select the Article Title and set to (17/20) 17 pt Font 2| x|
font and “Exactly” 20 pt line Spacing. Fonk | Character Spacing I Tewt EFfects |
« v « . Font: Fant stule: Size:
Use the same “Paragraph...” and “Font... [Times New Roman [Reguisr [ ]
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20.

Set the Author Names to (13/15) 13 pt font and
15 pt line spacing

21.

Set Author Affiliations to (8/10) italics; 8 pt font
with Exactly 10 pt line spacing.

22.

Set Keywords to (8/10), 8 pt font with Exactly
10 pt line spacing.




23.

Set each equation line to Single line spacing.

Select the one line that contains each equation
and go to “Paragraph...” under the Format
menu. Change line spacing to Single.

Click OK.

Note: It may be difficult to identify some
equation lines at the 10 pt line spacing, so
authors should compare to their unformatted
version to ensure that all equations appear
properly in the formatted version.
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24. Select the reference list (not including the
Reference heading) and set to (8/9) 8 pt font
with “Exactly” 9 pt line spacing.
25. Select each Table (all lines) an set to (8/9) 8§ pt
font with “Exactly” 9 pt line spacing..
26. Select each figure caption and set to (8/9) 8 pt
font with “Exactly” 9 pt line spacing..
27. Select all the text for the body of the paper, from 21|
the Introduction to the end of the References. == E— E——
a. Go to “Columns...” under the Format | = | == | = | == _ cacd |
menu. Set “Number of columns” to 2. S0 Wb aoe BE D
Mumber of columns: I 5‘ ™ Line between
b. Check the box for “Equal column width” N : _
L and spacing FEVIEW
c. Enter 2.67”(67.7 mm) for width (spacing ol Mo - i B
will adjust itself to match). [ e Ao
‘ | 2 [zerm H| =]
At this stage the text should be properly | | = =
formatted, and the Tables and Figures remain.

Do not apply two-column format to figures
and tables.

Apply bo: IThis section

j I~ start new column




28. Size each single column figure such that the
edges of the printed image extend to a width of
2.67 inch (67 mm).

Double-click on the figure to show the Format
Picture command window or go to “Picture ...”
under the Format menu.

Check the box to “Lock aspect ratio.”

Enter 2.67” (67 mm) for width, or larger if
needed to have the printed part of the figure
extend to the full column width. Click OK.

Alternatively, single-click on the figure and drag
the corner to adjust the size.

Note: Excess white space around each figure
border should be minimized before setting the
image size to fill the column width. This may be
done using the “Crop” tool.

Format Picture

Colors and Lines Size | Lavyout I Picture | Texk Box | ‘Web I

Size and rokate
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Rokation:

Sicals
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¥ Lock aspect ratio
[V Relative to original picture size
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29. Size each double column figure such that the
edges of the printed image extend to a width of
5.5 in (140 mm). Note that this is slightly less

than the full page width.

Again, extra white space around the edge of
each figure should be minimized.

30. Adjust tabs or table cell widths, as needed, so
that each Table fits properly in single-column or

full width format.

31. The few next steps insert an image of the
column boundaries and line numbers behind the
formatted paper. This will allow authors and the
Combustion Institute personnel to quickly

confirm proper formatting and length.

Download the file “PCI Column Format.jpg”
from the 30" Combustion Symposium site, if
you have not already done so.




32.

Scroll to the first page of the document and click - Fie Edt | view | Insert Format  Tools
anywhere on the page. 0= EE ol ]
Print Layout

33. Open the Header and Footer under the View Final Showing
menu III D Header and Fooker
34. Delete any eXiSting text in the header. File Edit Yiew | Imsert | Format Tools Table Window Help
. . . 3 Break... 3 . .| @
35. Insert the image “PCI_Columns.jpg” into the DEER ERARIRAR
header Final Showing Markug Zymbel... AR Rk AN
(L] | Picture » | (B clip art... —
Insert... Picture... From File... £] Text Box From Fie. .
Object... )
Bookmark. ..
36. Format the Layout to be “Behind text” and Formak RIS 2|
100% size. Colorsand Lines | Size  Layout | Picture | TextBox | web |

Wrapping style
Double click on the image to open the “Format p— 1
Picture” window or got to “Picture ...” under the b ’ o ’ r 1 Z—% ’ ~f

FOImat menu. In line with kext Sguare Tight Behind text  In front of text

With the Format Picture window still open, click  Horzontal signment

on the “Size” tab and confirm that the image is T Left Cocenter TRt other
100% for both height and width.
Click OK.
Advanced. .. |
OK I Cancel |

37.

Drag the image or use the cursor arrow keys to align the image with the formatted columns.
Alignment does not need to be exact. (Word prefers to align the image on it own grid.)

Close the Header and Footer.

This should place the column boundary image behind each page of the document.

Header and Footer

Tnsert AutoText = 7 (2 | @ By & F O |[Close

Close Header and Fu:u:uter|

38.

We recommend that authors do not apply two-column format to tables and figures unless
they are fluent with Word and are not using any full width tables or figures.

Generally, it will be simpler to leave the one-column format in place and adjust the “right
indent” on each figure caption to the 2.67-inch width. (See next step.)




39. For each single-column figure caption, click within the caption, and then move the “right-
indent” marker to match the 2.67 in width (or to the closest increment).
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40. Add page breaks as needed to prevent figure and caption from being separated.

41. Save the document. This completes the formatting process.

Make sure that the file name is of the form PID12345-formatted.doc.

42. Print the file.

43. Check that all figures are legible. A common problem with figures in the submitted
Symposium papers is illegibility of labels, legends, and plotting symbols due to the use of
fonts or symbols that are too small.

Authors should correct any legibility problems before attempting to submit their
paper. Papers will not be accepted for publication in the Proceedings of the
Combustion Institute until all figures are legible at the reduced size.

Note that the resolution used for figures in the CD version of the Proceedings is relatively
course compared to a laser printed version. Figures must be easily legible in print if they
are to maintain legibility in the final electronic version.




44. Calculate the page equivalent length of the paper.

The maximum allowed length is 7-1/3 pages. This reserves 2/3 page for Comments in the
final Proceedings. The equivalent page length of this formatted paper should be determined
by adding together the full and partial pages.

Partial pages are measured in terms of column length in units of inches, mm, or 10-pt lines.
To determine page equivalent length:

a. Count the number of full text pages.

b. Determine the total column length used on all the partial pages.

Sum the lengths of the partial columns on each page. This may be done in units of
inches (8.5 inch total column height), mm (216 mm total column height), or lines
(61 total 10-pt lines). Multiply by 2 for double column tables and figures.

c. Convert the partial columns to equivalent pages. Divide the result in b. by:
(17 column inches/page) or
(432 column mm/page) or
(122 column lines/page)

d. Combine the number of total and partial pages. If the sum is greater than 7-1/3
pages, the paper MUST be shortened BEFORE it is submitted.

45. Convert the reformatted file to PDF for upload along with your cover letter to the
Colloquium Co-Chair.

a. Embed all fonts in the pdf file.
b. View and print the pdf file to ensure that figures are legible.
c. The upload URL in given on the Author Checklist

If you have problems with this reformatting process that cannot be resolved locally, contact
Robert Barlow, Sandia National Laboratories, (barlow(@ca.sandia.gov).
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(Use Times New Roman font. Numbers

Table 1(8/9)
Parameters of the velocity field at the time when the
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in parentheses give font size and line spacing.)

Simulation u’/l I/nk Re, Re N knaxNK

R2 1.015 272 32 78 256° 3.88]
R3 1.010 422 52 153 256°  2.50
R4 1.005 715 72 308 512°  2.95
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tu/l, initial large eddy strain rate; //nx; initial length-scale
ratio; Re;, initial Taylor Reynolds number.
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g I Measurements of scalar dissipation in a -
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10 turbulent piloted methane/air jet flame

11

g Adonios N. Karpetis, Robert S. Barlow™ 1
:g Combustion Research Facility, Sandia National Laboratories, Livermore, CA 94551-0969, USA 1
16 |
17

18 i
19 |
20
21 Abstract i
2 |
23 This paper describes the first results from a| new 'experimental facility that combines line-imaging]
74 measurements of Raman scattering, Rayleigh scattéring, and laser-induced CO fluorescence. Simultaneous]
75 sgingle-shot line measurements of major species, temperature, mixture fraction, and the radial component of]|
26 Scalar dissipation are obtained in partially premixed methane/air jet flames (25% CH,, 75% air, by volume). The
27 experimental set up and methods of data analysis are|described. Results from a laminar jet flame and a piloted]
28 turbulent flame (Sandia flame D) are presented. The laminar and turbulent flames both show a local minimum in]
29 the average scalar dissipation near the stoichiometric mixture fraction. In the turbulent flame the radial|
3( ¢omponent of the instantaneous scalar dissipation jnear the stoichiometric condition displays a log-normal
31 distribution at high values and an exponential distribution at low values. This is attributed to variation in the]
32 Orientation of the three-dimensional mixture fraction gradient relative to the one-dimensional measurement. The]
33 ¢ffect of scalar dissipation on flame structure is examined, based on average species mass fractions doubly]
34 conditioned upon mixture fraction and scalar dissipation. The length scale of fluctuations in mixture fraction in
35 the turbulent reaction zone is derived from the measured single-shot radial profiles at each streamwise location. |
36 This macro length scale in well resolved by the present methods, shows correlation over radial distances of a few
37 millimeters, and grows with streamwise distance as the jet/flame spreads. The length scale for fluctuations in]
38 Scalar dissipation is less than one millimeter at each of the measured streamwise locations in the turbulent flame.
3
43 Keywords: Turbulent flames; Scalar dissipation; Raman scattering |
41 i
42
43 i
44 i
45 | | i
46 1. Introduction progress in fuel-rich conditions is sensitive to the
47 applied strain or scalar dissipation rate. Therefore,
48 Scalar dissipation is a central concept in the| accurate modeling of scalar dissipation is expected to |
49 theory and modeling of turbulent nonpremixed and be especially important for partially premixed |
50 partially premixed flames [1]. There is a need for] turbulent flames, making them good candidates for |
51 ¢xperimental data on scalar dissipation in the present experiments. Pitts et al. [4] provide a
52 Hydrocarbon  flames that can support the] review of scalar dissipation measurements in |
53 development and validation of improved combustion | nonreacting jets. Measurements in turbulent flames |
54 models. For example, comparisons of measured and | are more limited because scalar dissipation, defined |
55 modeled results for partially premixed methane/air as ¥y =2D,(VEeVE), where & is the mixture
56 Jet flames [2,3] have shown that conditional moment | fraction and Dy is its diffusivity, is obtained from the |
57 ¢losure (CMC) and steady flamelet models, each of spatial deriva-tive (in at least one dimension) of the |
58 Which depend on a submodel for conditional scalar | mixture fraction, which is difficult to measure |
59 dissipation, over predict the progress of reaction in | accurately in flames on a single-shot basis with good |
60 fuel-rich conditions. It is known from studies of spatial resolution. Nandula et al. [5], Chen &
61 laminar partially premixed flames that reaction] Mansour [6], and Brockhinke et al. [6] used KrF |
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xcimer lasers and intensified CCD arrays to obtain
ingle shot measurements of the radial component of

excited fluorescence
interferes with Raman scattering

ecause laser
1ydrocarbons
neasurements.

ublished results on scalar dissipation from such
neasurements.

nixture fraction in methane flames
{owever, the measurement of all the ma_]or species,
vhich should yield the best accuracy in mixture |
raction, is currently practical only in the context of|
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cattering, Rayleigh scattering, and laser-induced CO

ames. Temporally resolved measurements were

f 25% CH, and 75% air, by volume.
2. Experimental Methods

2.1 Line-Imaging Raman/Rayleigh/LIF system

f

!

S

7 beam (532 nm) with the 1064 nm beam of the next |
laser in the series, before it passed through the |
doubling crystal. Collimating telescopes in three of |
the lasers allowed for matching of the waists of the]
four beams.
volume was avoided by separating the pulses in time
by 200 ns and by using a three-leg pulse stretcher,
v

Using a 500 mm lens.

f the pulse stretcher.
neasured using a thermoelectric Joule-meter. Due
o hardware problems the present experiments were |
onducted using roughly 0.9 J/pulse out of the 2.4]
/pulse that the system can deliver to the probe
olume. Excitation of CO followed the methods

sandia [e.g. 3].
undamental to reach 230 nm. Laser pulse energy

as measured using a photodiode, and the|
‘ombination of a A/2 plate and Glan laser prism was

O = Eh=h A L e ot

calar dissipation in turbulent H, jet flames.]
Methane flames present a greater challenge [7-10]]
of higher]

While line imaging of Raman|
cattering has been applied in turbulent nonpremixed |
1ydrocarbon flames [11], we are not aware of any |

There is ongoing work to develop |
echniques for two-dimensional measurements of|
[12-14].

ine imaging. This paper presents the first results]
rom a facility that combines line imaging of Raman |

Tuorescence to obtain measurements of temperature, |
e major species concentrations, mixture fraction,
nd scalar dissipation in turbulent hydrocarbon

ybtained along radial segments in a piloted CH,/air |

25 jet flame (Sandia flame D [2,15]) and in a laminar jet |
flame (flame A [15]) with the same fuel composition

The experimental set up is shown in Fig. 1. Four |

requency-doubled Nd:YAG lasers were used in the ]
Raman/Rayleigh  system. Dichroic  optics |
uccessively combined each frequency-doubled

Dielectric breakdown in the probe_

:hich extended each pulse to about 80 ns (FWHM)‘:
[he combined beam was focused into the test section
Alignment of the multiple]|
beams was accomplished using seven motor-driven |
mirror mounts, one for each laser and one in each leg |
The pulse energy was|

leveloped for multiscalar point measurements at |
A seeded Nd:YAG laser pumped a |
unable dye laser, and the dye laser beam was|
requency doubled and then mixed with the Nd:YAG |

used to attenuate pulse energy and maintain it in the

range (~1.5 mJ/pulse) that yielded a nearly linear |
and CO|
fluorescence signal along the length of the imaged |
This reduces the influence of collisional |
quenching [3], and corrections for variation in the

dependence between laser energy

region.

q:uenching rate were not applied.

Raman scattered light was collected using a|
custom designed pair of 150-mm diameter achromats |

(Linos Photonics, f/2 and f74), which were mounted

face to face, yielding a magnification of 2. The f/4 |
lens matched the entrance aperture of an imaging |
spectrometer, which was fitted with a high-speed |

rotating mechanical shutter [9,16,17]. This shutter

provided a 9 ps gate, rejecting flame luminosity and |
allowing the use of a non-intensified CCD array |
The shutter also provided timing signals |

detector.
for the lasers and cameras.

A 16-bit, back-illuminated, cryogenically-cooled:
CCD (Princeton Instruments VersArray 1300B with
1300x1340 pixels) was used for detection of the |

Raman spectrum. The performance of such cameras
is superior to that of intensified cameras, with regard
to quantum efficiency, noise, and dynamic range, as
described by Miles [16]. The image of the laser |
beam was rotated by a periscope to align with the
vertical entrance slit. A grating of 588 grooves/mm
dispersed the Stokes Raman spectrum (550-700 nm)
along the horizontal axis of the CCD detector.
diameter of the probe volume was determined by the

~250 pm waist of the combined laser beam, the |
image of which (500 pm after magnification) fits |
In order to

through the 800 um rotating slit.
minimize readout noise and hence improve the |
overall signal-to-noise ratio (SNR), CCD pixels were
binned on chip to form superpixels. For the present |

experiment 23 superpixels were defined along the |

spatial dimension of the CCD, corresponding to a |
spatial resolution of 300 um along the laser beam,
and 15 superpixels were defined along the spectral
dimension. The CCD detector allowed for arbitrary |
specification of the location and width of superpixel |

columns, and these spectral superpixels collected
photons corresponding to the rotational- v1brat10nal
Raman spectrum of the major species (CO,, O, CO, |
N,, CH,, H,0, H,) and interferences in-between.

The Rayleigh imaging system used two matched |
300-mm fl, 1:1 |
conjugation), and the collected light was focused |

achromats (82 mm diameter,

onto a back-illuminated CCD detector (Roper

Scientific Spec-10 400B with 400x1340 pixels) |

through a 532-nm band-pass filter. Gating was
provided by a mechanical shutter and a ferro- electrlc
liquid crystal shutter. The horizontal image was

divided into 23 superpixels of 300 um, matching the |
Raman system. The vertical image was divided into |
15 pixels of 60 um, with upper and lower pixel rows |

being used for shot-to-shot subtraction of
background scattermg
The CO imaging system used the same front

collection lens as the Rayleigh system. A dichroic |

The |
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1

?Ieam splitter in the collimated region reflected CO
uorescence from the B'S'(v'=0)—4'"(v'=1) band
~484 nm) through another matched achromat.

i
I
intensified CCD camera (Andor) with 512x512
pixels.

\

i

vertical direction, with the outer pixels again being |
u ised for background subtraction.

2.2. Data analysis

Processmg steps for the Raman, Rayleigh, and
CO LIF images included: dark frame subtraction, |
¢orrection for non-uniform throughput and response |
1ormalization by laser energy. The signals from
calar quantities using an iterative matrix inversion

rocess similar to that
neasurements [e.g. 3,8]. Diagonal elements of the

F W S S T W 7 <

»f laser-excited interferences. Here we have used

The 560-nm signal is stronger and less affected by |
ross-talk from CH4.) The major species mole
ractions from the Raman/LIF measurements were |
ised to determine the species-weighted Rayleigh |
cattering cross section, and the resulting Rayleigh |
emperature was iteratively applied in calculating the |
emperature  dependent matrix elements, until |
onvergence to <1K was achieved. The LIF]
echnique is superlor to Raman scattering for the
neasurement of CO in methane flames [8,18], and
JIF results for CO are used exclusively in this paper.
Mixture fraction was calculated from the]
measured species mass fractions, Y;, usmg the Bilger |
formulation [19] modified as in previous work on
these partially premixed flames to exclude the
xygen terms [3,15]. This reduces sensitivity to]
measurement noise and interferences.
diffusivity was evaluated as:

=S S W S SR

D =-0.12013 + 0.74818(7/1000) +
1.1631(7/1000)* (cm/s),

\
f
partially premixed CHy/air flame with a strain
B

pline smoothing with the error constraint on mixture
fraction set at

An|
interference filter centered at 484 nm (10 nm|
“WHM) passed the CO fluorescence signal onto an |

As for the other systems, the imaged region |
vas divided into 23 superpixels along the length of|
he laser beam. Seven superpixels were used in the |

»f each imaging system, background subtraction, and |
ach superpixel element were then converted to:
developed for point]

natrix include a calibration factor and a temperature |
lependent bandwidth function for each species. Off- |
liagonal elements account for the temperature-|
lependent cross-talk among species and the effects |

the signal from the C, band near 560 nm, rather than |
the band near 615 nm, to correct for interferences. |

The mixture |

()

vhich is a fit to the mixture-averaged diffusivity-
rom a calculation of an opposed-flow, laminar,-

sarameter for the Tsuji configuration of ¢=25 s [3].
['wo methods for determining the radial derivative of
¢ were investigated, spline smoothing and central,
differencing. Results presented here are based on-
S

0.005 + 0.005¢ to account/

approximately for measurement uncertainty. Scalar |
dissipation

statistics (pdf shapes and conditional means) were |
relatively insensitive to error constraints between |
zero and the level applied here. Central differencing |
yielded scalar dissipation statistics very similar to |
those presented below.

3. Results and Discussions
3.1 Laminar flame results and measurement precision

Measurements were obtained in a laminar |
partially premixed ]et flame (flame A [15]) in order |
to evaluate the precision of repeated measurements.
The standard deviation in mixture fraction |
measurements (unsmoothed) in this flame varies |
from about 5% in lean conditions to 0.9% in very
rich conditions. Standard deviation in the measured_
scalar dissipation varies from ~17% to ~30%.
However, this level of precision is still quite useful |
in the turbulent flame, where instantaneous y values
(presented below) are distributed over 3-4 orders of |
magnitude.  (For simplicity, » is used in the|
remainder of this paper to denote the measured radial |
component of scalar dissipation.) The measured
profile of y in this laminar jet flame has two peaks, |
with a local minimum just to the rich side of the |
stoichiometric ~ mixture  fraction,  &=0.35. |
Calculations of laminar opposed-flow flames [3] |
show a similar double-peaked structure. However,
the measurements yield a rich-side peak in scalar |
dissipation that is roughly three times that on the |
lean side, while the corresponding ratio in the |
calculation is less than two. This reflects a
difference in structure between the axisymmetric Jet
and opposed-flow configurations. Note that the
shape of the scalar dissipation profile can depend on |
how mixture fraction is defined. Therefore, |
consistent definitions should be used in such |
comparisons.

3.2 Scalar dissipation statistics in turbulent flame D |

Flame D in the series of piloted CHy/air Jet
flames [15] has been a target of numerous model

calculations [e.g. 2,20-22]. It is an appropriate flame |
for this investigation of scalar dissipation because it |
has a relatively high Reynolds number, Re=22,400, |

but a low probability of localized extinction. Line
measurements were obtained at streamwise positions |
of x/d=7.5, 15, and 30. In each case the flame was |
a_hgned so that the imaged segment
approximately centered on the mean stoichiometric
contour.

location.

Results for the radial component of scalar |
two- |
are |

dissipation are presented
dimensional density plots.
constructed  from  one-dimensional

in Fig. 2 as
These plots

was |

1000 shots, the equivalent of 23,000 point |
measurements, were acquired at each streamwise |

probability
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ensity functions (pdf’s) of scalar dissipation
onditioned upon the mixture fraction, such that each

!
hence the presentation of pdfilng|&). The darker
1

fraction, (In (x| &) )-

There is a clear trend
of y with

ield is not fully turbulent.
wards smaller values

ich samples, is also evident. The double-peak

ine in F1g 2) at all three streamwise locations. The
ocal maxima in y are higher on the fuel-rich side of
he flame, which is consistent with previous
neasurements [5,6] and LES results [20].
alues of the conditional average (,|¢) at the r1ch-
ide maxima (&~0.5) are 63, 42 and 16 s

N - R =]

ocal minima (near &, =
ull three-dimensional results for scalar dissipation

el =S ==

The one-dimensional pdf of yat
toichiometric condition,  pdfilny&,),
5 significance for both theory and modeling of reacting
flows.
og-normal distribution for this pdf, while some

©w_ wn

lifferent shape [6]. Here, this pdf was generated
in was selected around the stoichiometric value, as

ig. 2, to provide sufficient statistical accuracy. The

/an “n T |Am

here the pdfilny&,) is plotted in log-arithmic

appearing as a parabola in such a plot). The left

ippears closer to an exponential (and hence a

isotropic turbulent flows, the deviation from log-

ormality for the smaller values of scalar dissipation |
an be considered an artifact of the 1D measurement. |
s the instantaneous gradient vector, V{deviates |
rom the radial direction, the 1D technique registers |

e projection of the vector along » and consequently

lower values of y This can be seen in Fig. 2, where |

e deviations from log-normality become more

epresented value of & (each vertical slice) has equal |
robability. As suggested by Chen & Mansour [6], |
icalar dissipation is examined in logarithmic space, |
ireas correspond to higher probability. The solid |
ine in each density plot represents the average value |
f scalar dissipation conditioned upon the mixture |
Scalar dissipation is broadly distributed at all]
measured positions in the flame except on the fuel- |
lean side close to the exit (x/d=7.5), where the flow |
increasing |

ownstream distance, manifested both in the density_

lots and the average values. The streamwise decay
in & manifested in the progressive erosion of very |
tructure noted in the laminar jet flame persists in the |

urbulent flame. A local minimum in y can be seen:
1ear the stoichiometric value (marked by a dotted

The |
! for|
/d=7.5, 15, and 30, respectively. The corresponding |
0.35) are 17, 10, and 4 s

re expected to be higher by a factor between 2 and:

the |
has |

Experiments in cold flows [4,23] suggest a |
xperiments in reacting flows have suggested a|
rom measurements at x/d=7.5, 15, and 30. A large:
hown by the lines and arrows in the density plots in |
esults are shown in the lower graphs in Fig. 2,:
rrdinate. For each streamwise location the right side |
of the pdf, corresponding to the high values of ycan |
be approximated by a log-normal distribution |

ide of the pdf, corresponding to small values of y|

S
49 4
straight line in each graph). As explained in [24] for |
i

pronounced as distance from the exit increases, and
the flame orientation varies more from the radial. |
Future experiments will include simultaneous planar |
imaging to determine the instantancous flame |
orientation and curvature. i

3.3 Influence of scalar dissipation on species

The present measurements allow direct |
assessment of the effects of scalar dissipation on
turbulent flame structure and reaction progress. i
Instantaneous realizations (not shown here) glve
clear illustrations of turbulence-chemistry coupling.
For example, CO levels on the fuel-rich side of the
reaction zone are significantly reduced in single-shot |
profiles with high local scalar dissipation. The joint |
conditional statistics of mixture fraction, scalar |
d1551pat10n and reactive scalars may be analyzed in
various ways, which we can only begln to address |
here. We will approach the issues in the context 0f
classic ideas that describe a turbulent flame as a
collection of strained laminar flamelets [1]. Every |
measurement point (¥;, & ) may be considered as a
part of a doubly conditioned flamelet (conditioned |
on & and y). The previous section dealt with the |
results in the (&) plane of the multidimensional
scalar space that describes the turbulent flame. In |
what follows, we will consider results in planes of
(% 9 and (Y, »).

There are at least two possibilities for calculating |
doubly conditioned averages of state variables: one |
is to condition upon the local scalar dissipation, y; |
another is to condition upon the scalar dissipation at |
the closest stoichiometric condition, ¥, , along the
instantaneous radial segment. The latter is presented
here because it is more consistent with the |
theoretical treatment of flamelets, which are

typically described according to the stoichiometric |
value of scalar dissipation [1]. Fig. 3 presents results |

1n the form (Y, | &, y,,) for HO, CHy, CO, and H,.
Data from all three streamwise rneasurernent
locations were combined, and conditioning on y,,
was performed using the five logarithmic intervals

listed in the figure caption. Arrows indicate in the:
1 Changes in the flamelet |
structure appear for the highest values of y,, and
they are confined around the stoichiometric value, as |
anticipated by the conditioning method (upon y;). |
representative  of |

direction of increasing y;.

The water mass fraction is
temperature, CO, and overall reaction progress and
is shown first. As y,, increases, the local mixing time
(1/ v) decreases. This translates to a decrease of |

local Damkoler number and leads to the observed |

reduction  of Y201 &, Zﬂ)m Fig. 3. A
corresponding effect is seen in the results for |
[ R Higher values of y, result in |
increased leakage of CH, across the stoichiometric |
condition and into the lean side of the flame. The |

intermediates, CO and H,, show a more pronounced |
effect of scalar dissipation, which is most apparent |

on the fuel-rich side, where peak levels of CO and
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1, are reduced as y, increases. The behavior of
pecies mass fractions shown in Fig. 3 is the

Damkoler number [1,25], and it is qualitatively |
Jonsistent with results from steady laminar flame|
alculations performed over a range of scalar
lissipation rates.

urbulent CHy/air flame.
The present measurements

= S S N o S .

also

onditioned upon the stoichiometric —mixture

nsure that only the local stoichiometric flamelets
re included in the ensemble.
he most vigorous burning condition and the largest

lotted against logz,, The result corresponds to the
pper burnrng branch of an S-shaped curve

SN S~ G — S O W T

than logl/ 7, that corresponds to tlme)

Y0 | £0z,,) TOT Values approaching »  ~ 400 !

prediction of the S-shaped curve for single-step

shape of the curve and not for reasons of
omparison, because

»arameters that the model requires. The presence or

he structure of the instantaneous results at a constant
calar dissipation, Ko»

bi-modal distribution of values y
¢ expected, cor-responding to both

{ Ot 5 t>Xo
the lower stable branches of the S-shaped curve.
q
o

-:.4 Spatial structure of turbulent flame D

calar  quantities
neasurements [6], leading to the calculation of |
ength scales pertinent to turbulent combustion. The
1ormalized auto-correlation,

5 o= =

<a'(x,r)a'(x,r+Ar >

R, (x,7,Ar) = ,
<a(x,r) > <a(x,r+ Ar>”

scale [,

[, (x,r) = I R, (x,r,Ar)dAr

xpected response of flame structure to decreasing |

The novel contribution of the]
resent work is that these doubly conditioned species |
nass fractions are quantified for the first time in a|
provide |
nformation on the approach to extinction. As an|
llustration, we consider the mass fraction of water |

ractlon &y, and the instantaneous stoichiometric |
icalar dissipation, y,;. By con-ditioning on f st We

These correspond to |
alues of local and instantaneous Y. In Fig. 4 the |

oubly conditioned average ‘YHZO | £y Zst> is |

mirrored, since we use the abscissa log 7, rather:
The_
approach to extinetion is clearly seen by the dip i in
['he curve drawn through the data is a quasi- analytlc:

kinetics and for judicious choice of parameters [26]. |
It is plotted as a visual aid to indicate the expected |

a of the many adjustable
B

absence of localized re-ignition can be judged from |
i

$ below the extinction limit. In]
regions having significant extinction and re-ignition
would |

e upper and |

Samples corresponding to the lower (re-ignition)]
pranch were not observed in the present experiment. |

Two-point and multi-point spatial correlations of |
can be calculated from line|

2 ]

rnay be calculated for any scalar a. The quantity R,m:
may then be integrated over Ar to produce a length- |

©))

The length-scales for fluctuations in mixture

fraction (¢ = #) and fluctuations in scalar dissipation |
(a = y ) have been calculated and are plotted in Fig. |
5 as a function of axial distance, x/d. The former, /, |
corresponds to a macro-scale of turbulence, while |

the latter, /,, is characteristic of the length scale
where most scalar dissipation occurs.

tacitly suppressed, and the length-scales
considered representative of the reacting region at

each axial position. The scale /; is well resolved in |
this experiment and increases with axial distance as |
the flame spreads. However, /, is greatest at x/d=7.5 |

and decreases with axial distance. This trend may

result from the transitional character of the flame in |
suppresses |
Better spatial resolution, which will be

the near combustion
turbulence.
achieved in future experients, will be needed to
confirm the quantitative behavior of ,, but it is clear |
that fluctuations in scalar d1ss1pat10n are only
correlated over distances of less than 1 mm at these |

turbulent flame conditions.

field, where

4. Conclusions

Measurements of the major species mass
fractions, mixture fraction, and the radial component
of scalar dissipation were obtained in laminar and |

turbulent methane/air jet flames (flames A and D), |

using simultaneous line imaging of Raman
scattering, Rayleigh scatterlng, and laser-induced CO |
fluorescence. Local minima in the conditional scalar
dissipation near the stoichiometric condition are
exhibited by both types of flames. Pdfs of scalar |
dlssrpatlon conditional upon mixture fraction are |
broadly distributed about the conditional mean.
One-dimensional pdfs of the radial component of the |
conditional  scalar  dissipation  around the
stoichiometric mixture fraction exhibit log- normal
behav1or for high scalar dissipation values but appear |
to follow an exponential distribution for low scalar |
d1551pat10n values, and this is attributed to variation |
in the orientation of the instantaneous three-
dlmensronal gradient in mixture fraction. Average
species mass fractions, doubly conditioned upon |
mixture fraction and scalar dissipation, clearly show

the effects of high scalar dissipation and finite rate |
chemistry on flame structure, including the approach |
to extinction in the turbulent flame. The length scale |

of turbulent fluctuations in mixture fraction across

the reaction zone shows the effect of jet spreading |
and shows positive correlation over distances of a |
The length scale of fluctuations in |

few millimeters.
scalar dissipation is less than 1 mm at the three
measured locations in flame D.
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I-ig. 1. Experimental system for simultaneous line imaging c-f Ramal_n scattering, Rayleigh scattering, and CO LIF. J
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Fig. 2. Top row: density plots of scalar dissipation for the three-axial positions ( x/d = 7.5, 15, and 30) in flame D. Darker

e average conditional scalar dissipation (In (| &) ) is plotted as a
tioned upon the mixture fraction around the stoichiometric value
re used to form the 1D pdfs. Solid lines represent exponential and|

ly. | i
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0 0.2 0.4 g 0.6 0.8 1

Fig. 3. Average species mass fractions doubly
conditioned on the local value of & and on the value of]
scalar dissipation at the nearest stoichiometric location, i,/
in each instantaneous profile. The five plotted lines|
correspond to five logarithmic intervals used for binning .|
.01-0.1, 0.1-1, 1-10, 10-100, and 100-1000 (all values in s
'). The arrows indicate increasing g, and the dashed line|

shows the stoichiometric condition.
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Fig. 4. Average water mass fraction doubly conditioned on|
stoichiometry (&) and on the local value of scalar
dissipation y,.  Line: S-shaped curve (mirrored) for|
extinction of single-step reaction (from [26]). Dashed
portion corresponds to the unstable branch of the curve. 1

ol
—o—|
x

3F

10 15 20 25 30
x/D

ig. 5. Length scales of turbulent fluctuations in the
nixture fraction (l2) and scalar dissipation (/,) measured in|
lame D. The dashed line corresponds to the experimental
esolution limit.

= e = e

61 lines for Fig 3 + 44 lines for Figs 4, 5.
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